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Introduction 
 
The rapid changes in the field of Computer Aided Engineering (CAE) have brought 
exciting advances in the engineering community. Recent advances have made the long-
sought goal of concurrent engineering closer to a reality. CAE has become the core of 
concurrent engineering and is aimed at reducing design time, producing prototypes faster, 
and achieving higher product quality. SOLIDWORKS is an integrated package of 
mechanical computer aided engineering software tools developed by Dassault Systèmes 
SOLIDWORKS Corporation. SOLIDWORKS is a tool that facilitates a concurrent 
engineering approach to the design and stress-analysis of mechanical engineering 
products. The computer models can also be used by manufacturing equipment such as 
machining centers, lathes, mills, or rapid prototyping machines to manufacture the 
product. In this text, we will be dealing only with the solid modeling modules used for 
part design and part drawings. 
 

 
Computer Aided Engineering 

(CAE) 
 
  

     Computer Aided Design             Computer Aided Manufacturing 
           (CAD)                   (CAM) 
 
   

 Computer Geometric Modeling         Computer Aided Drafting 
 

  Finite Element Analysis 
 
 
Development of Computer Geometric Modeling 
 
Computer geometric modeling is a relatively new technology, and its rapid expansion 
in the last fifty years is truly amazing. Computer-modeling technology has advanced 
along with the development of computer hardware. The first generation CAD programs, 
developed in the 1950s, were mostly non-interactive; CAD users were required to create 
program-codes to generate the desired two-dimensional (2D) geometric shapes. Initially, 
the development of CAD technology occurred mostly in academic research facilities. The 
Massachusetts Institute of Technology, Carnegie-Mellon University, and Cambridge 
University were the leading pioneers at that time. The interest in CAD technology spread 
quickly and several major industry companies, such as General Motors, Lockheed, 
McDonnell, IBM, and Ford Motor Co., participated in the development of interactive 
CAD programs in the 1960s. Usage of CAD systems was primarily in the automotive 
industry, aerospace industry, and government agencies that developed their own 
programs for their specific needs. The 1960s also marked the beginning of the 
development of finite element analysis methods for computer stress analysis and 
computer aided manufacturing for generating machine toolpaths. 
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The 1970s are generally viewed as the years of the most significant progress in the 
development of computer hardware, namely the invention and development of 
microprocessors.  With the improvement in computing power, new types of 3D CAD 
programs that were user-friendly and interactive became reality. CAD technology quickly 
expanded from very simple computer aided drafting to very complex computer aided 
design. The use of 2D and 3D wireframe modelers was accepted as the leading edge 
technology that could increase productivity in industry. The developments of surface 
modeling and solid modeling technologies were taking shape by the late 1970s, but the 
high cost of computer hardware and programming slowed the development of such 
technology. During this period, the available CAD systems all required room-sized 
mainframe computers that were extremely expensive. 
 
In the 1980s, improvements in computer hardware brought the power of mainframes to 
the desktop at less cost and with more accessibility to the general public. By the mid-
1980s, CAD technology had become the main focus of a variety of manufacturing 
industries and was very competitive with traditional design/drafting methods. It was 
during this period of time that 3D solid modeling technology had major advancements, 
which boosted the usage of CAE technology in industry. 
 
The introduction of the feature-based parametric solid modeling approach, at the end of 
the 1980s, elevated CAD/CAM/CAE technology to a new level. In the 1990s, CAD 
programs evolved into powerful design/manufacturing/management tools. CAD 
technology has come a long way, and during these years of development, modeling 
schemes progressed from two-dimensional (2D) wireframe to three-dimensional (3D) 
wireframe, to surface modeling, to solid modeling and, finally, to feature-based 
parametric solid modeling.  
 
The first generation CAD packages were simply 2D computer aided drafting programs, 
basically the electronic equivalents of the drafting board. For typical models, the use of 
this type of program would require that several to many views of the objects be created 
individually as they would be on the drafting board. The 3D designs remained in the 
designer’s mind, not in the computer database. Mental translations of 3D objects to 2D 
views are required throughout the use of these packages. Although such systems have 
some advantages over traditional board drafting, they are still tedious and labor intensive. 
The need for the development of 3D modelers came quite naturally, given the limitations 
of the 2D drafting packages. 
 
The development of three-dimensional modeling schemes started with three-dimensional 
(3D) wireframes. Wireframe models are models consisting of points and edges, which are 
straight lines connecting between appropriate points. The edges of wireframe models are 
used, similar to lines in 2D drawings, to represent transitions of surfaces and features. 
The use of lines and points is also a very economical way to represent 3D designs. 
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The development of the 3D wireframe modeler was a major leap in the area of computer 
geometric modeling. The computer database in the 3D wireframe modeler contains the 
locations of all the points in space coordinates, and it is typically sufficient to create just 
one model rather than multiple views of the same model.  This single 3D model can then 
be viewed from any direction as needed.  Most 3D wireframe modelers allow the user to 
create projected lines/edges of 3D wireframe models. In comparison to other types of 3D 
modelers, the 3D wireframe modelers require very little computing power and generally 
can be used to achieve reasonably good representations of 3D models. However, because 
surface definition is not part of a wireframe model, all wireframe images have the 
inherent problem of ambiguity. Two examples of such ambiguity are illustrated. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wireframe Ambiguity: Which corner is in front, A or B? 

A non-realizable object: Wireframe models contain no surface definitions. 
 



  Getting Started 1-5 

Surface modeling is the logical development in computer geometry modeling to follow 
the 3D wireframe modeling scheme by organizing and grouping edges that define 
polygonal surfaces. Surface modeling describes the part's surfaces but not its interiors. 
Designers are still required to interactively examine surface models to insure that the 
various surfaces on a model are contiguous throughout. Many of the concepts used in 3D 
wireframe and surface modelers are incorporated in the solid modeling scheme, but it is 
solid modeling that offers the most advantages as a design tool. 
 
In the solid modeling presentation scheme, the solid definitions include nodes, edges, and 
surfaces, and it is a complete and unambiguous mathematical representation of a 
precisely enclosed and filled volume. Unlike the surface modeling method, solid 
modelers start with a solid or use topology rules to guarantee that all of the surfaces are 
stitched together properly. Two predominant methods for representing solid models are 
constructive solid geometry (CSG) representation and boundary representation (B-
rep).  
 
The CSG representation method can be defined as the combination of 3D solid 
primitives.  What constitutes a “primitive” varies somewhat with the software but 
typically includes a rectangular prism, a cylinder, a cone, a wedge, and a sphere. Most 
solid modelers also allow the user to define additional primitives, which are shapes 
typically formed by the basic shapes. The underlying concept of the CSG representation 
method is very straightforward; we simply add or subtract one primitive from another. 
The CSG approach is also known as the machinist’s approach, as it can be used to 
simulate the manufacturing procedures for creating the 3D object. 
 
In the B-rep representation method, objects are represented in terms of their spatial 
boundaries. This method defines the points, edges, and surfaces of a volume, and/or 
issues commands that sweep or rotate a defined face into a third dimension to form a 
solid. The object is then made up of the unions of these surfaces that completely and 
precisely enclose a volume. 
 
By the 1980s, a new paradigm called concurrent engineering had emerged. With 
concurrent engineering, designers, design engineers, analysts, manufacturing engineers, 
and management engineers all work together closely right from the initial stages of the 
design. In this way, all aspects of the design can be evaluated and any potential problems 
can be identified right from the start and throughout the design process. Using the 
principles of concurrent engineering, a new type of computer modeling technique 
appeared. The technique is known as the feature-based parametric modeling technique.  
The key advantage of the feature-based parametric modeling technique is its capability to 
produce very flexible designs. Changes can be made easily and design alternatives can be 
evaluated with minimum effort. Various software packages offer different approaches to 
feature-based parametric modeling, yet the end result is a flexible design defined by its 
design variables and parametric features.   
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Feature-Based Parametric Modeling 
 
One of the key elements in the SOLIDWORKS solid modeling software is its use of the 
feature-based parametric modeling technique. The feature-based parametric modeling 
approach has elevated solid modeling technology to the level of a very powerful design 
tool. Parametric modeling automates the design and revision procedures by the use of 
parametric features. Parametric features control the model geometry by the use of design 
variables. The word parametric means that the geometric definitions of the design, such 
as dimensions, can be varied at any time during the design process. Features are 
predefined parts or construction tools for which users define the key parameters. A part is 
described as a sequence of engineering features, which can be modified/changed at any 
time. The concept of parametric features makes modeling more closely match the actual 
design-manufacturing process than the mathematics of a solid modeling program. In 
parametric modeling, models and drawings are updated automatically when the design is 
refined. 
 
Parametric modeling offers many benefits: 
 

• We begin with simple, conceptual models with minimal detail; this approach 
conforms to the design philosophy of “shape before size.” 

 

• Geometric relations, dimensional constraints, and relational parametric 
equations can be used to capture design intent. 

 
• The ability to update an entire system, including parts, assemblies and drawings 

after changing one parameter of complex designs. 
 

• We can quickly explore and evaluate different design variations and alternatives 
to determine the best design. 

 

• Existing design data can be reused to create new designs.  
 
• Quick design turn-around.  
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Getting Started with SOLIDWORKS 
  

 
• SOLIDWORKS is composed of several application software modules (these 

modules are called applications), all sharing a common database. In this text, the 
main concentration is placed on the solid modeling modules used for part design. 
The general procedures required in creating solid models, engineering drawings, 
and assemblies are illustrated.  

     
How to start SOLIDWORKS depends on the type of workstation and the 
particular software configuration you are using. With most Windows 
systems, you may select SOLIDWORKS on the Start menu or select the 
SOLIDWORKS icon on the desktop. Consult your instructor or 
technical support personnel if you have difficulty starting the 
software. The program takes a while to load, so be patient.  
 
The tutorials in this text are based on the assumption that you 
are using the SOLIDWORKS default settings. If your system 
has been customized for other uses, contact your technical 
support personnel to restore the default software configuration. 
 
Once the program is loaded into the memory, the SOLIDWORKS program window 
appears.  This screen contains the Menu Bar and the Task Pane.  The Menu Bar contains 
a subset of commonly used tools from the Standard toolbar (New, Open, Save, etc.), 
the SOLIDWORKS menus, the SOLIDWORKS Search oval, and a flyout menu of Help 
options.  By default, the SOLIDWORKS menus are hidden.  To display them, move the 
cursor over or click the SOLIDWORKS logo. 
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If the Task Pane does not appear to the right of the screen, right click on the Menu Bar to 
reveal a menu of toolbars and select the Task Pane, or select View from the 
SOLIDWORKS Menus and select Task Pane.  Other options for the Task Pane are the 
Design Library and the File Explorer.  The icons for these options appear below the 
SOLIDWORKS Resources icon.  To collapse the Task Pane, click anywhere in the 
main area of the SOLIDWORKS window.  (NOTE:  If the Task Pane does not collapse 
upon clicking in the graphics area, it has been ‘pinned’ using the Auto Show button in the 
upper right corner.  Simply left-click on the icon to unpin the Task Pane and allow it to 
collapse.) 
 

 
 
The following two startup options are available: New and Open.  The New option 
allows us to start a new modeling task. The Open option allows us to open an existing 
model file.  These two commands can be executed in the Getting Started dialog box in 
the SOLIDWORKS Resources task pane or on the Menu Bar.  The Getting Started dialog 
box also contains a Tutorials option which provides some quick helps that illustrate the 
features and general procedures of using SOLIDWORKS.  

Task Pane 

Menu Bar 

SOLIDWORKS Resources Icon 

Startup Options 

Common Tools 

SOLIDWORKS 
Menus (hidden) 
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Ø Select the New icon on the Menu Bar with a single click of the left-mouse-
button.  The New SOLIDWORKS Document dialog box appears. 
  

Ø NOTE:  If the Units and Dimensions Standard dialog box appears, click OK to 
accept the default settings.   

 
Three icons appear in the New SOLIDWORKS Document dialog box. Selecting the 
appropriate icon will allow creation of a new Part, Assembly, or Drawing file. A part is 
a single three-dimensional (3D) solid model. Parts are the basic building blocks in 
modeling with SOLIDWORKS. An assembly is a 3D arrangement of parts (components) 
and/or other assemblies (subassemblies). A drawing is a 2D representation of a part or 
assembly. 
 

 
 
Ø Select the Part icon as shown.  Click OK in the New SOLIDWORKS Document 

dialog box to open a new part file. 
 
 
Units Setup 
 

• When starting a new CAD file, the first thing we should do is to choose the units 
we would like to use.  The Unit system for the active document is shown on the 
Status Bar at the bottom of the SOLIDWORKS window (e.g., millimeter, gram, 
second as shown).    We will use the English (feet and inches) setting for this 
example. 
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Ø Select the Options icon from the Menu Bar as shown to 
open the Options dialog box.  (The Options dialog box can 
also be opened from the Tools pull-down menu.)   

 

 
Ø When the Options dialog box opens, the System 

Options tab is active.  The Units setup is located 
under the Document Properties tab.  Select the 
Document Properties tab as shown. 

 
 
Ø Select Units on the left menu as highlighted below.  Select IPS (inch, pound, 

second) under the Unit system options.  Select .123 in the Decimals spin box for the 
Length units as shown to define the degree of accuracy with which the units will be 
displayed.  Click OK at the bottom of the Document Properties - Units window to set 
the units.  (Notice IPS now appears on the Status Bar at the bottom of the window.) 
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SOLIDWORKS Screen Layout 
 
The default SOLIDWORKS drawing screen contains the Menu Bar, the Heads-up View 
toolbar, the FeatureManager Design Tree, the CommandManager (below the Menu Bar), 
the task pane (collapsed to the right of the graphics area in the figure below), and the 
Status Bar. (Note:  If the CommandManager is inactive, the Features toolbar will appear 
vertically at the left and the Sketch toolbar will appear vertically at the right.) A line of 
quick text appears next to the icon as you move the mouse cursor over different icons. 
You may resize the SOLIDWORKS drawing window by clicking and dragging at the 
edges of the window, or relocate the window by clicking and dragging at the window title 
area.  
 
 
 
 

 
 
• Menu Bar Toolbar  

 
In the default view of the Menu Bar, only the toolbar options are visible.  The default 
Menu Bar toolbar consists of a subset of frequently used commands from the Menu Bar 
as shown above.    

Graphics 
Area 

Feature Manager 
Design Tree 

Menu Bar 
Heads-up View Toolbar 

Status Bar 

Reference Triad 

Command Manager 
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• SOLIDWORKS Pull-down Menus 
 
To display the pull-down menus, move the 
cursor over or click the SOLIDWORKS 
logo.  The pull-down menus contain 
operations that you can use for all modes of 
the system.  
 
 
 
 
 
 
 
 
 
 

• Heads-up View Toolbar 

 
The Heads-up View toolbar allows us quick access to frequently used view-related 
commands.  NOTE:  You can hide or customize the Heads-up View toolbar. 
  
• Features Toolbar 

 
The Features toolbar allows us quick access to frequently used features-related 
commands, such as Extruded Boss/Base, Extruded Cut, and Revolved Boss/Base.  
When the CommandManager is used (with the Use Large Buttons with Text option 
turned OFF) the Features toolbar appears as shown above.  When the CommandManager 
is turned OFF, the Features toolbar is displayed (by default) vertically at the left of the 
SOLIDWORKS window.   
 
• Sketch Toolbar 

 
The Sketch toolbar provides tools for creating the basic geometry that can be used to 
create features and parts.  When the CommandManager is used (with the Use Large 
Buttons with Text option turned OFF), the Sketch toolbar appears as shown above. 
When the CommandManager is turned OFF, the Sketch toolbar is displayed (by default) 
vertically at the right of the SOLIDWORKS window.   
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• CommandManager 
 

The SOLIDWORKS CommandManager provides one 
method for displaying the most commonly used 
toolbars.  If the CommandManager is not visible, it can 
be turned ON by right clicking on any toolbar and 
selecting CommandManager from the top of the pop-
up menu list of toolbars.  

 
The CommandManager is a context-sensitive toolbar that dynamically updates based on 
the user’s selection.  When you click a tab below the CommandManager, it updates to 
display the corresponding toolbar. For example, if you click the Sketches tab, the Sketch 
toolbar appears. By default, the CommandManager has toolbars embedded in it based on 
the document type.    
 
The display of the CommandManager is (with the Use Large Buttons with Text option 
turned on)shown below, once with the Features toolbar selected, once with the Sketch 
toolbar selected.  You will notice that when the CommandManager is used, the Sketch 
and Features toolbars do not appear on the left and right edges of the display window. 

 
To turn OFF the CommandManager and use the standard 
display of toolbars, right click on the CommandManager 
(or any other toolbar) and toggle the CommandManager 
OFF by selecting it at the top of the pop-up menu.  When 
the CommandManager is ON, the display can be toggled 

using the Use Large Buttons with Text.  With the option ON, the toolbars appear as 
shown above; with the option OFF, the toolbars appear as shown on the previous page. 
 
IMPORTANT NOTE:  Many lessons in this text use the standard display of toolbars.  If 
a user prefers to use the CommandManager, the only change is that it may be necessary 
to select the appropriate tab prior to selecting a command.  For example, if the instruction 
is to “select the Extruded Boss command from the Features toolbar,” it may be 
necessary to first select the Features tab on the CommandManager to display the 
Features toolbar.   
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• Standard Display of Toolbars 
 

The default SOLIDWORKS drawing screen using the standard display of toolbars, with 
the CommandManager turned OFF, is shown below.  The Features toolbar appears at the 
left of the window and the Sketch toolbar at the right.  This is the standard view used in 
the lessons in this text. 

 
• Mouse Gestures 

 
You can use a mouse gesture as a shortcut to execute some common commands. To 
activate a mouse gesture, move the cursor inside the graphics area, hold the right mouse 
button down and drag the mouse.  A gesture guide appears showing command mappings 
for the gesture directions.  Drag the mouse (while holding the right button down) across 
the appropriate button to execute the command.  
 
There are separate gesture guides for drawings, assemblies, 
parts, and sketches.  The appropriate guide appears based on 
the current operation.  For example, in sketch mode a gesture 
guide with sketch commands appears as shown here. You 
can customize up to eight gestures for each guide.  To view 
or edit the current mouse gesture assignments, select 
Customize on the Tools pull-down menu, then select the 
Mouse Gestures tab. 

Features Toolbar 

Sketch Toolbar 
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• FeatureManager Design Tree/PropertyManager/ConfigurationManager/ 
DimXpertManager/DisplayManager 

 
The left panel of the SOLIDWORKS window is used to display the FeatureManager 
Design Tree, the PropertyManager, the ConfigurationManager, the DimXpertManager 
and the DisplayManager.  These options can be chosen by selecting the appropriate tab at 
the top of the panel.  The FeatureManager Design Tree provides an overview of the 
active part, drawing, or assembly in outline form. It can be used to show and hide 
selected features, filter contents, and manage access to features and editing.  The 
PropertyManager opens automatically when commands are executed or entities are 
selected in the graphics window, and is used to make selections, enter values, and accept 
commands.  The Configuration Manager is used to create, select, and view multiple 
configurations of parts and assemblies.  The DimXpertManager lists the tolerance 
features defined using the SOLIDWORKS ‘DimXpert for parts’ tools.  The 
DisplayManager is used to control appearances, decals, scenes, lights, and cameras that 
are applied to the current model. 

FeatureManager 
PropertyManager 

ConfigurationManager 

DimXpertManager 

DisplayManager 
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•  Graphics Area 

 
The graphics area is the area where models and drawings are displayed.  
 

• Reference Triad 
The Reference Triad appears in the graphics area of part and assembly documents.  The 
triad is shown to help orient the user when viewing models and is for reference only.  
 
• Origin 
The Origin represents the (0,0,0) coordinate in a model or sketch.  A model origin 
appears blue; a sketch origin appears red.  
 
• Confirmation Corner 
The Confirmation Corner offers an alternate way to accept features.  
 
• Graphics Cursor or Crosshairs 
The graphics cursor shows the location of the pointing device in the graphics window. 
During geometric construction, the coordinate of the cursor is displayed in the Status Bar 
area, located at the bottom of the screen. The cursor’s appearance depends on the selected 
command or option.  
  
• Message and Status Bar 

 
The Message and Status Bar area displays a single-line description of a command when 
the cursor is on top of a command icon. This area also displays information pertinent to 
the active operation.  In the figure above, the cursor coordinates are displayed while in 
the Sketch mode. 

Reference Triad 

Origin 

Confirmation Corner 
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Mouse Buttons 
 
SOLIDWORKS utilizes the mouse buttons extensively. In learning SOLIDWORKS’ 
interactive environment, it is important to understand the basic functions of the mouse 
buttons.  
 
• Left mouse button 

The left-mouse-button is used for most operations, such as selecting menus and 
icons, or picking graphic entities. One click of the button is used to select icons, 
menus and form entries, and to pick graphic items.  

 
• Right mouse button 

The right-mouse-button is used to bring up additional available options in a context-
sensitive pop-up menu. These menus provide shortcuts to frequently used commands.  

 
• Middle mouse button/wheel 

The middle mouse button/wheel can be used to Rotate (hold down the wheel button 
and drag the mouse), Pan (hold down the wheel button and drag the mouse while 
holding down the Ctrl key), or Zoom (hold down the wheel button and drag the 
mouse while holding down the Shift key) realtime.  Spinning the wheel allows 
zooming to the position of the cursor. 
 
 

 

 
 
[Esc] – Canceling Commands 
 
The [Esc] key is used to cancel a command in SOLIDWORKS. The [Esc] key is located 
near the top-left corner of the keyboard. Sometimes, it may be necessary to press the 
[Esc] key twice to cancel a command; it depends on where we are in the command 
sequence. For some commands, the [Esc] key is used to exit the command. 

Picks icons, menus, 
and graphic entities. 

Brings up additional available 
options.  Allows quick Pan, 

Zoom, and Rotate. 
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On-Line Help 
 
v Several types of on-line help are available at any time during a SOLIDWORKS 

session. SOLIDWORKS provides many on-line help functions, such as: 
 

• The Help menu: Click on the Help option in 
Menu Bar to access the SOLIDWORKS Help 
menu system.  (NOTE: Move the cursor over the 
SOLIDWORKS logo in the Menu Bar to display 
the pull-down menu options.) The 
SOLIDWORKS Help option provides general 
help information, such as command options and 
command references.  The SOLIDWORKS 
Tutorials option provides a collection of tutorials 
illustrating different SOLIDWORKS operations.  
 

• The SOLIDWORKS Tutorials can also be 
accessed from the SOLIDWORKS Resources task 
pane on the right side of the screen by selecting 
Tutorials. 

 

• The SOLIDWORKS Help option can 
also be accessed by clicking on the Help 
icon at the right end of the Menu Bar.  

 
 
 
Leaving SOLIDWORKS 

  
 
Ø To leave SOLIDWORKS, use the left-mouse-button 

and click on File at the top of the SOLIDWORKS 
screen window, then choose Exit from the pull-down 
menu.  (NOTE: Move the cursor over the 
SOLIDWORKS logo in the Menu Bar to display the 
pull-down menu options.) 
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Creating a CAD Files Folder 
 
It is a good practice to create a separate folder to store your CAD files. You should not 
save your CAD files in the same folder where the SOLIDWORKS application is located. 
It is much easier to organize and backup your project files if they are in a separate folder. 
Making folders within this folder for different types of projects will help you organize 
your CAD files even further. When creating CAD files in SOLIDWORKS, it is strongly 
recommended that you save your CAD files on the hard drive.  
 
Ø To create a new folder in the Windows environment: 
 

1. In My Computer, or start Windows Explorer under the Start menu, open the folder 
in which you want to create a new folder. 
 

2. On the File menu, point to New, and then click Folder. The new folder appears 
with a temporary name. 

 
3. Type a name for the new folder, and then press ENTER. 
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NOTES: 
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